




II. Software Installation






Please read this section thoroughly.  If these instructions are not followed, the Auto-Mate software may operate incorrectly - or not at all.





System Requirements

The following minimum system requirements should be adhered to when installing your software.



CPU:  200mHz Pentium (or Equivalent) or Higher



Memory (RAM):  128 Megabytes [256 Megabytes recommended].  (The system may work with 32 or 64 Megabytes RAM, but audio playback may experience occasional sputtering or skipping - especially as it transitions from one item to the next.



CD-ROM:  Double Speed, or higher.  (For software installation).



Video:  VGA Color Monitor or greater.  Video Card should be capable of supporting High Color - 16 Bit minimum.   The screen size should be capable of being set to 800 x 600 pixels.  

 

Hard Drive:  Depending on whether compression is used and how many recordings are planned to be placed on the system, the amount of hard-drive requirement varies.  Use the following table as a guide:



Recording Setting [Bytes used Per Minute Table]�Mono  (Megabytes per min.)�Stereo (Megabytes per min.)��PCM (Standard .WAV file)  44kHz  8 Bit�2.6 Megabytes per min.�5.2 Megabytes per min.��PCM (Standard .WAV file)  44kHz  16 Bit  �5.2 Megabytes per min.�10.4 Megabytes per min.��PCM (Standard .WAV file)  22kHz  8 Bit�1.3 Megabytes per min.�2.6 Megabytes per min.��PCM (Standard .WAV file)  22kHz  16 Bit�2.6 Megabytes per min.�5.2 Megabytes per min.��Microsoft ADPCM  (4 Bit) 44kHZ�1.3 Megabytes per min.�2.6 Megabytes per min.��MPEG Layer 3[Mp3](128 kilobytes / second [kbps]) �.5 Megabyte per min.�1 Megabyte per min.��

For real-time recording, we have found Microsoft ADPCM to offer good sound quality with a minimal amount of hard-drive usage. For music, we highly recommend MP3 for outstanding sound quality with a minimum of hard drive and resource usage.  Existing .WAV files can be easily converted to MP3 using third party software.   MP3’s can also be easily ‘ripped’ from your CD’s using a variety of low-cost software packages.  This is often quicker and easier than recording files in real-time.



To give an idea of how much hard-drive is needed, we will use Microsoft ADPCM Stereo recording as an example.



At 2.6 megabytes of hard-drive used per minute, this equates to 6.4 hours of recording per one gigabyte of hard drive capacity.  So, knowing this, we can equate that approximately 96 four minute songs per gigabyte.  From this, it can be determined how many gigabytes are needed based on the number of desired recordings.  For example, if  around 1000 recorded songs are desired, it would be advisable to purchase at least an 11-12 gigabyte hard-drive.  With today’s huge drive capacity at low prices, it is advisable to go with the largest affordable drive.



Recording Setting [Hours of Recording Time per Gigabyte]�Mono  (Hours of Recording per recording type.)�Stereo (Hours of Recording per recording type.)��PCM (Standard .WAV file)  44kHz  8 Bit�6.4 Hrs per gigabyte�3.2 Hrs per gigabyte��PCM (Standard .WAV file)  44kHz  16 Bit  �3.2 Hrs per gigabyte�1.6 Hrs per gigabyte��PCM (Standard .WAV file)  22kHz  8 Bit�12.8 Hrs per gigabyte�6.4 Hrs per gigabyte��PCM (Standard .WAV file)  22kHz  16 Bit�6.4 Hrs per gigabyte�3.2 Hrs per gigabyte��Microsoft ADPCM  (4 Bit) 44kHZ�12.8 Hrs per gigabyte�6.4 Hrs per gigabyte��MPEG Layer 3 [Mp3]�33.33 Hrs per gigabyte�16.67 Hrs per gigabyte��

We don’t recommend using full 44kHz 16 bit stereo recordings, as the tremendous amount of throughput tends to bog down most systems, and performance can become unstable over a period of time.   Of course, your results may vary.

Audio Quality/Compression Options [Codecs]:

Sound cards have a wide variety of quality.  To keep things simple, one usually gets what one pays for.  It is better to stick with high-quality rather than going for the $9.95 no-name special at the discount warehouse.  Still, an excellent quality sound card can usually be obtained for around $50.  The next biggest determining factor of audio quality, besides the electronics of the sound card itself, is the audio compression (for file size) capability.



The compression that can be used is software dependent.  That is, the Windows system uses what are known as Audio ‘Codecs’ to determine the fidelity, whether the recording is stereo or mono, and any file size compression.  The codecs installed from one PC to the next vary.  Windows comes equipped with Microsoft ™ ADPCM ™ compression.  If MPEG Layer 3 ™ is desired, this may or may not be equipped on your PC.  Obtaining (usually by downloading from the web) the latest version of the Microsoft Windows Media Player ™ will give you most of the latest playback codecs.  Different compression recording codecs can be added by purchasing software which creates compressed recordings.  This software may be searched for with keywords ‘CD ripper’, ‘multimedia editor’, ‘audio software’, ‘compression codecs’ etc.   Consult your local software reseller or website for various options.   Usually, codecs must be licensed by the respective copyright owner - so these options must be purchased as part of a software package that creates audio files using one method or another.



Keep in-mind that some recording codecs will not work properly with your Auto-Mate recording software.  The only way to know for sure is to try it.  Some codecs are designed only for converting existing files, as opposed to making real-time recordings.  It is sometimes hard to tell one from another.  A safe bet is to make a recording using a standard format (e.g. .WAV) and convert it to a desired format (e.g. MP3).



We have found that the Microsoft ADPCM format is widely available (standard in Windows95 and higher) and offers a good compromise between sound quality and hard-drive space savings.  The best part - it’s free!



Choosing/Installing the Sound Card(s):



Your first task will be to install the sound card or cards inside of your computer, should it not already exist.  To accomplish this, please refer to the instructions that came with your sound card and the previous section.  Make sure that you check the operation of the card using the built-in test programs that come with your sound card software package. 



There are many sound cards that will function with your Auto-Mate Software.  The only requirement is that it work with the Windows operating system, and be able to record and play .WAV files - as virtually all consumer grade cards do.  However, there are some more intricate details that will affect the performance of your Auto-Mate software.







Audio Overlap Capability:

The Auto-Mate is capable of audio overlap during playback, and this is possible in two situations:



Two Sound Cards are installed in the P.C.  See Two Sound Card Installation instructions below for full details.



Note:  You may have to install two separate models of sound card in the computer, as some systems may not    

recognize duplicate cards.



One Sound Card is installed - AND has Audio Accelerator capabilities (this allows multiple channels to originate on a single sound card.)  Note that this is not the same as DIRECT SOUND™  OR DIRECTX™ capability.  A sound card may be DIRECT SOUND compatible, but may not be able to overlap on the same card.  Consult documentation from your sound card manufacturer for information regarding whether Accelerator capability is available.



We cannot know definitively which sound cards will work for overlapping.  We do know that the SoundBlaster PCI 512  or the SoundBlaster LIVE or Audigy ™ series cards  work for overlapping on a single sound card.



Recording vs. Playback:

It is generally not possible to record and play on the same sound card simultaneously using Auto-Mate Software.  Some sound cards may support this, but we do not recommend this.  For simultaneous record and playback, it is recommended that two sound cards be installed in the unit.  See the following instructions for Two Sound Card Installation.



Two Sound Card Installation:

� EMBED Word.Picture.6  ���

Installing two sound cards in the Windows 95 and higher environment is relatively easy.  Simply install each sound card one-at-a-time, and install all appropriate sound card software.  Refer to the documentation that came with the sound card.  If installation problems are encountered, contact the sound card manufacturer for technical support.  Auto-Mate Systems cannot assist in sound card installation due to the variations from one card to another.





Once both sound cards are installed, enter the Multimedia properties of the Windows Control Panel.  This is accessed as follows:



Start > Settings > Control Panel > Multimedia 



From here, in the Audio Tab of Multimedia properties, the preferred device for playback and recording can be selected.  As long as both sound cards have been installed correctly, each will appear in the drop-down selection box.



Important Note:  For dual sound card overlapping playback, make sure the ‘Use Only Preferred Devices’ box is un-checked.  Again, For both sound cards to function during playback the ‘Use Only Preferred Devices’ box should not be checked.  Otherwise, the Preferred sound card for playback will only be used.  Of course, this means that overlap will not occur.  This box should only be checked if overlap is never desired, or an Audio Accelerator is being used which is capable of playback overlap on the same sound card.



For recording, it is important that a recording preference be selected if more than one sound card is installed.  Since the Audio inputs and outputs will likely be permanently wired, it is important to complete this step.  



If there is only one sound card in the system, there is no need to adjust this setting.

 

Overlapping Playback with Single Sound-Card

If overlapping sound card is desired with a single-sound card, the card must be equipped with an Audio Accelerator.   The Sound Card should be installed, and all accompanying software should be installed with the sound card.  The ‘Use Only Preferred Device’ box should be checked in the Multimedia properties (as shown on the previous page).  This should allow the same sound card to overlap audio.  Still, there are instances where the overlapping function will not work.  Due to the many circumstances in which this may occur, it is recommended that dual sound cards be used instead.

DirectX - DirectSound Installation:

If DirectSound - part of the DirectX multimedia enhancement is available, it should be installed.  Direct Sound is an enhancement designed by Microsoft which allows multiple channels of audio to be played from the same sound card in certain applications.  This feature is built-in to Windows 98 and above.  The Auto-Mate does not specifically use Direct Sound components, but there may be advantages in using this in conjunction with other software.



Installing the Auto-Mate Software



After you have confirmed the proper operation of the sound card(s), it is time to install the Auto-Mate software.



The software will create five new directories:



C:\AMATE  - For the program files.

C:\AMDATA - For the data file of all recordings.

C:\AMWAVE - For the actual .WAV files (recordings).�XE "Recording"� An additional AMWAVE directory is created on all other 			             resident  hard drives in your system.

C:\AMTEMPLT- Stores the templates you have created in the Pick-List mode.  These templates will have a file 				  extension of .TPP (Pick-List).  Satellite templates are also stored in this directory with an 				  extension of .TPL and .TPD.   Satellite verification logs are also stored here with an extension of 				 .LOG.  A variety of operational data files are stored here as well.

C:\AMTIME- Stores Time of Day .WAV recordings.



It is critical to note that the Auto-Mate operating software must be placed on drive C in the AMATE directory.  If for some reason you don't have a drive C or it has insufficient space, you must re-configure your system so it will accept The Auto-Mate software on drive C.  The Auto-Mate Windows Ver 4.0 will use about ten megabytes of hard drive space for the operating program.  Also, even if you don't plan to use drive C for recording, make sure there is enough space for the data files, templates, and verification log files.  Generally, you will want to have at least  100 megabytes reserved on your C drive at all times for these data storage functions

  

Your Auto-Mate software package consists of a CD-ROM.  The files are compressed on the CD, and will be "expanded" to normal size on the hard drive.  



To install The Auto-Mate, please follow these instructions closely:



Web Download:



If downloading Auto-Mate from the internet, it will be a ‘ZIP’ file called AMATE4.ZIP..  You will need WinZip ™ or similar ‘unzipping’ software to ‘extract’ the files.   The .ZIP file should be saved and then you should extract the files to any convenient directory.  Then, find the directory that the files were extracted to and run ‘SETUP.EXE’.  Your unzipping software may be sophisticated enough to extract and execute the setup file on it’s own.  If so, the process will be even easier!



CD ROM Installation:



Auto-Mate software comes on a single CD-ROM.  After placing the CD into drive, installation should begin automatically.  If it does not, change to the CD drive and run the program SETUP.  The installation is very straightforward.  The user must agree to the license terms, or the installation will terminate. 





NOTE:  It is critical that the default C:\AMATE directory be selected for installation.  This is done by pressing the graphic button (displaying a PC) on the installation program.



The install utility will allow you to change the install directory, but doing so will render your system inoperable and the software will need to be un-install and reinstalled in C:\AMATE if a different installation directory was selected.



Once the software has been copied from the CD to the hard drive, the system settings will be updated.  After installation completes, the Auto-Mate may be accessed by selecting start > programs > Auto-Mate.



Installation will complete when the Auto-Mate is run for the first time.  Additional record and playback controls must be installed and configured.  Once this is complete, please reboot the PC to make sure that all updates are registered by the operating system.



It is noted in the installation that at least two recordings of each type must be made before attempting playback.  The system is designed to hold hundreds, if not thousands of recordings of each type (spots, music, liners), but has difficulty if there is not at least a minimal amount of selection in the database files.  Please record at least two spots, liners, and music files before attempting to use the Random, On-Air Assist, or Pick-List modes.



The main menu that runs each application is called AMWIN.EXE.  This is the main menu application.  To create a desktop icon for Auto-Mate, complete the following steps:



1. Right click mouse on the desktop

2. Click 'New'

3. Click 'Shortcut'

4. Click 'Browse'

5. Browse for and once located, click the AMATE folder in drive C

6. Locate file AMWIN in the list and double-click

7. The file C:\AMATE\AMWIN.exe will appear in the command line window.

8. Click 'Next'

9. Select a name for the shortcut that makes sense to you (i.e. Auto-Mate)

Click Finish



The icon will appear on your desktop





Uninstalling/reinstalling software:  



NOTE:  Uninstall and Re-install your software if you are installing an upgrade!!  If you use the uninstall utility as shown below, no existing system settings will be harmed.



An occasion may arise when it becomes necessary to un-install the Auto Mate from the PC.  This will likely occur if the PC is being replaced or upgraded, and the Auto-Mate software must be removed to comply with the license agreement.  An un-install should also be performed anytime a re-install or upgrade of the software will be performed.  Failure to un-install the previous version may not allow new files to overwrite the pre-existing files.  



NOTE:  This process will not affect existing data, .WAV/.MP3, Time, or template files.



To un-install the existing software, follow these instructions:



Start > Settings > Control Panel > Add-Remove hardware.



In the list of currently installed hardware, Auto-Mate will be listed.  Highlight Auto-Mate and choose "remove program."  This will un-install the program files and certain system registry files.  While the software is un-installing, a message may appear that certain files are shared -- or may be used by another application.  When in doubt, it is best to retain the OCX or other registry files to insure all other system programs remain unaffected.





Memory Management/Reliability - IMPORTANT!



First, a few words on reliability.  The following pages discuss memory and system resources as they relate to system reliability.  Regardless of what may be written here, your results may vary.  The best course of action for reliability is to REBOOT YOUR P.C. AT LEAST ONCE EVERY 2 to 3 DAYS!  After several days of continuous use, the system reliability is reduced due to the complexity and cumulative effect of system load.  To avoid dead-air, don’t rely on the system to operate indefinitely.  Check your system often, and put it on a regular reboot schedule. 



Memory Overview:



The original Auto-Mate software was designed under DOS.  It is rock-solid when it comes to reliability.  To be quite honest, I held off writing the software for Windows™ for several years.  The reason - Memory!   At running the risk of angering the mighty Microsoft, the way Windows manages memory leaves something to be desired.  One problem is that in Windows, we have to contend with the needs of other software applications that are running.  Windows  compensates by ‘managing’ the memory.  In regards to Multimedia applications (such as Auto-Mate), Windows is particularly challenged by the large file sizes and perceived burden on its resources.   One by-product of this is that Windows will try all sorts of ‘tricks’ such as buffering pieces of the audio to the system memory and then using a ‘swap’ file (or Virtual Memory) on the hard drive once the actual RAM is used up.  The swap file also continues to be taxed as your application runs, and eventually runs low on space. Once your system’s memory is compromised, so is the reliability of the application you are running.  When you have problems depends on how big the swap file is (which is usually dependent on how much hard drive space is free on the C drive).  To make matters worse, Windows uses some other techniques that can continue to suck up memory and never release it until you reboot the computer.



With Auto-Mate, you may wish to operate unattended for several days (or longer) without operator intervention.  This presents a particular challenge.  If you plan to operate for short time spans (i.e. less than 24 hours continuous)  just about any configuration should work.  Windows generally manages its own resources, and even if it mismanages the memory, there should be no problems if the software is used for short-term runs.  Please be advised that this applies only if you reboot the P.C. after using it.  If you were to run Auto-Mate at night, then shut-down the PC when arriving in the morning, you should have no problem.  But, if you run it all night and then leave the P.C. turned on sitting idle all day, you are likely just picking up where you left off when starting the playback the next evening.  Eventually, the system will fail - but it will just take longer than a playback mode that is running 24x7.   



Another drawback to the Windows Swap File and other Windows memory management techniques is found during the recording of audio files.  If the hard drive swap file is in use while a recording is being made, short gaps can become audible in the recording.  To avoid these problems, it is best to make your recordings in a freshly booted machine, and do not generally make the recordings while the system is in playback mode.  To increase the quality of your recordings to the highest level, you should consider using a cache manager such as CACHEMAN (see below).



Reliability Tests:



For a three month period in Fall 2000, The Auto-Mate V4 Playback was tested for long-term reliability in relation to it’s interface with the Windows operating system.  The results are as follows:



1.   Mode Tested:  Random Playback Mode:   Test System: Pentium MMX 233 CPU.  128 MB RAM.  Virtual Memory (Swap File):  6769MB Maximum.  [Swap file is allowed to use up to 6.7 gigabytes of free space on test hard drive - but probably does not ever use that much].



Findings:  Maximum reliability using default Windows memory management:    132 Hours average in continuous unattended operation (5.5 days).  After this time, the system memory became unstable.   Audio playback would sputter and eventually cease completely, with the text windows going blank and turning white.  The only remedy when this occurred was to reboot the P.C..





2.  Mode Tested:  Pick-List Playback Mode:   Test System: Pentium MMX 233 CPU.  96 MB RAM.  Virtual Memory (Swap File):  21MB Maximum.  [This system had a very small swap file].



Findings:  Maximum reliability:    60 hours average in continuous unattended operation (2.5 days).  After this time, the system memory became unstable.   Audio playback would sputter and eventually cease completely, with the display windows going blank and turning white.    The only remedy when this occurred was to reboot the P.C..







3.  Mode Tested:  Random Playback Mode:   Test System: Pentium MMX 233 CPU.  128 MB RAM.  Virtual Memory (Swap File):  Disabled.  [This system had no swap file].



Findings: Maximum reliability:   12 hours average in continuous unattended operation.  After this time, the system memory became unstable.   Audio playback would sputter and eventually cease completely, with the display windows going blank and turning white.    The only remedy when this occurred was to reboot the P.C..





Overall Findings:  System reliability is longer with larger swap files - but increase in longevity is not proportionate to the swap file size.  The best case scenario using standard Windows memory management seems to be about 5 days of continuous operation before the P.C. must be rebooted.  Your results may vary - and will tend to be a bit longer if you have a large amount of free hard drive space.  



Note:  You can see how much virtual memory is available on your system by doing following:



Start > Settings > Control Panel > System > [Performance] > [Virtual Memory].



Almost always, the ‘Let Windows manage my virtual memory settings’ is selected.  The amount of potential swap file is shown in the grayed out ‘Hard Disk’ window.   There is an option for setting your own virtual memory, but it doesn’t seem to help to try to set these yourself. 



For those who need longer reliability:



Some users wish to ‘set it and forget it.’  As we have always stated, it is not advisable to leave the system unattended for days or weeks.  However, there are some tricks we have found that vastly increase the potential longevity of the playback.  Again, if you plan to shut-down the P.C. every day or two, you should not need to worry about it.  But, if you want to run the software continuously, we recommend that you try a cache manager.  



We have evaluated several products.  RAM managers (such as FreeMem)  are useful for showing how much free RAM is available on the P.C.  Some can even free up memory that has been used.  Unfortunately, we found that freeing up conventional RAM is useful, but seems only to slightly slow the appearance of system instability.  More drastic intervention is required.  As stated above, the built-in Windows memory management techniques seem to be of no help.  What to do?



We have found a handy utility called CACHEMAN.  It seems to do a wonderful job managing the Windows memory difficulties.  It tames VCACHE which is a particularly nasty memory waster when working with large multimedia files. It is freeware, so there is no charge!



This software is included with the Auto-Mate package, or you can get the file by going to www.outertech.com.  Download and install to your P.C. It works great!  Once you have installed CACHEMAN, select Settings and then click ‘Multimedia’.  This will optimize Windows for the Multimedia environment automatically.  Make sure and reboot the P.C. after adjusting the setting.  



The P.C. should always be booted to bring up the memory manager automatically.  In the case of Cacheman, there is a box in the ‘options’ tab that can be checked to cause Cacheman to open every time Windows is started.  You can also place the CACHEMAN, or other memory manager in your Windows Startup File so it is always running whenever the P.C. is rebooted.



To place CACHEMAN (or other memory manager) in the startup file:



Click Start > Settings > Taskbar (or Taskbar & Start Menu) > [Start Menu Programs] > Advanced > Programs > Startup (double click)



Then Click File > New > Shortcut .  Then browse until you find Cacheman.exe (or other .exe if you are opening another manager).    Then click Next and Finish.



Now, the CACHEMAN will open everytime the P.C. is rebooted.



It is advisable to monitor the status of the free memory from time-to-time. Eventually, the system will become unstable, as some memory is always used for its operation.  We cannot know how long it will be before your system NEEDS to be rebooted, because it varies depending on your system memory and other applications that are running. 



Obtaining/Entering Registration Code



Your Auto-Mate software can run full-featured for up to 45 days in any individual P.C. before you decide to purchase.  When payment is received, and you send us the encryption file, we will send you the unlock code which will allow unlimited future use of the software on the installed P.C..  



To receive the unlock code:



Upon entering the Auto-Mate, a box will appear and within it the choice to ‘Register Now’ or ‘Register Later’.  





When you are ready to purchase the software, you must submit the registration code that is generated with the ‘Create Registration Code’.  There are several ways to generate your code:



You can highlight the contents of the data file, then right-click and press COPY.  You can then paste the contents into an e-mail and send to automate@wvi.com. 

The registration you generate is also saved in a file in the C:\AMATE directory and is called SUBMIT.DAT.  You can attach that file to an e-mail and send it to automate@wvi.com.  

 If your Auto-Mate equipped P.C. does not have e-mail capability, the SUBMIT.DAT file in C:\AMATE can be saved to a floppy and then attached to an e-mail sent from a different P.C.

In a worst-case scenario, you can write out the letter-number combinations you see.  This is not desired, because there is an increased risk of  error.



We have learned from several sad experiences, that disseminating unlock codes over the telephone simply does not work.  



When we have received your payment and your code, we will generate the unique code for your computer.  This will be sent to you by e-mail.  Once again, click the Register Now!  Button when you enter the Auto-Mate software.  You should then copy and paste the numbers into the ‘Enter Unlock Code’ window (see above).  If you cannot paste the file, the numbers can be entered manually.  Please be very careful when doing so, as the letter-number combinations must be entered exactly. 



The unlock code supplied may have blank spaces to the left of the row of codes.  The computer ignores any leading spaces, but the unlock code should be entered top-to-bottom, as provided.



Note: If your e-mail is in a different computer, you can also save your e-mail as a text file by clicking File > Save As *.txt file.  Save the file to a floppy diskette, and take to your PC with Auto-Mate.  Open the text file using Word Pad or Notepad.  Then copy and paste into the ‘Enter Unlock Code’ window.



Note:  Your software will only work on the Computer in which it is installed.  If it is installed on another PC, it will need another registration code.



Obtaining Additional Registration Codes:



We realize that there may be occasions in which the software must be re-installed in a P.C. due to upgrading or equipment failure.  If you need a new code, please e-mail us the code (as explained above).  A brief explanation of what happened to necessitate the change is appreciated.  You must also provide your Auto-Mate Serial Number (the 8 digit alpha-numeric code).   This can be found by going to Help > About Auto-Mate.  The serial number should have been entered when the software was initially provided.



Auto-Mate Systems will charge an administrative fee for excessive code regeneration. 



If you wish to install the software in an additional P.C., such as a production system, there will also be an additional affordable fee to generate an additional code(s).



See technical support policies for further information on this matter.  Our web site www.auto-matesystems.com will have current policies.





Serial Number:



The serial number is different from the ‘Unlock’ code.  The serial number does not have an impact on the operation of the software, but if it is not entered, you will see a ‘nag’ message at the top of the screen stating ‘Demo - please register’.  When you purchase the software, we will provide you with a serial number for the software.  Basically, this is just a way to help us differentiate hardware in the field and expedite service.  It is like a customer number, but a customer may have multiple serial numbers if they have purchased multiple installations.



If you have pre-purchased the software before trying the demo, you may be able to enter the serial number when you do the initial installation.  Or, you can always enter the serial number at anytime by going to Help > Enter Serial Number.  Only a valid serial number issued by Auto-Mate Systems will be accepted when you enter the serial number.  Again, please do not confuse the serial number with the unlock code.  
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